
If you have never used FM3 before, this guide aims to get you up and running by
showing you the general overview of the software. By the end of the document, you
should be familiar with the different features available, but should you need any more
information please contact our support team.

Starting the “Server Services”

There is a windows “Service” that runs in the background to provide the “Licence Service” for FM3, which allows you to
log into the FM3 database. This, and the dbManager application should already have been configured for you so if you
have problems, please contact Technical Support.

Starting FM3

You can start FM3 like any other windows application, but selecting its icon from the “Start” menu, or by double clicking
its icon on your desktop (depends upon how you have been configured). Once started, FM3 will display a user login
window. Here, you can enter your User ID and Password (if you have one), in order to log-in.

In the "Database" drop-down, you might have more than one database entry. Usually, it houses Live and Test - select the
one you need, and use the login credentials given to you to log-in to the software.

Another option available during logging-in is the “Invoicing date”. This date is the default used during job costing and
invoicing. Setting this to another date allows you to run invoices as though they were raised on that date. This invoicing
date is also used to control charge entry in order to prevent users from logging into the application outside a date range
specified by the accounts department (as per their requirements you may only be allowed to log in within two dates,
which could either be the current financial month/period, or the current financial year).

To log in, you can enter your user name and password (if you have one), or try “ADMIN” if this is a demo database. Once
logged in, the “Dashboard” should appear. This will default to the “Home” page wherein you will find more details on how
to use FM3. Just click on the links as you need in order to browse the on line help. For now however, click on the “tour of
the FM3 interface” link (seen in purple in the screen shot below).

If the dashboard does not load and you are left with a grey background, double-click on that background or go to View --
> Dashboard to load the screen.
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Getting around the interface

FM3 adopts a standard windows GUI (Graphical User Interface) to allow you access to its various functions. Along the
top of the main application window you will see a menu bar, starting with the “File” menu. You can click on any of these
menu items to get a list of options allowing you to perform required tasks (such as “NEW” from within the File menu, in
order to create a new job).

Immediately below the menu bar is the “tool bar”. This presents the most common functions as quickly accessible
buttons, each with an image which represents its function. You can hover the mouse over any of these to see a quick
“tool tip” that describes the buttons purpose.
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Below the toolbars, you can find the “job windows” taskbar. This works in a similar way to the windows task list, where
each window you open within FM3 is given a button in this bar. This allows you to quickly switch between jobs and data
windows without having to close/minimise them.

At the very bottom of the FM3 application window you should find the status bar. This gives a quick overview of which
database you are connected to, the login name you used, and the access group to which you belong. Next to this is the
“status” message area, which is updated with information as tasks are carried out (or with more details when you hover
for a tool tip). After the status message area, is the date/time you used to log into the application with.

Toolbars

The toolbar row of icons is actually made up of 4 individual toolbars. Let’s go through each of these toolbar icons in turn
and explain how you can use them (and when).

File toolbar

This is the main toolbar you will probably use, to create jobs, save changes to them, and to print out “reports”.
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What is a “Job”?

Before we go about creating a job, we should perhaps first cover what FM3 thinks a job is. For the most part, FM3 sees
an individual job as a collection of different documents which may make up the entire job process.

So, you may start out by creating an “Export Job” document and give it a file reference of “EXP123”. You would fill out
the various boxes on this document window, and then perhaps would want to raise a House AWB. You would do this by
adding an HAWB document to the job window, and then filling out the extra boxes presented there (certain values from
your initial job document having been copied through to the HAWB). You could then attach a set of costing charges to
your job and then raise an invoice, before finally attaching a POD document. All of these documents would be attached
to the single job reference window.

The diagram above shows the job (EXP123) as being the entire set of documents, or rather, the box. Each document
within that job, whether it is the “Export Job” itself, or the “BOL”, the “HAWB”, etc, are included in that job, and will each
have their own reference number within it. Naturally you can keep adding other documents as your wish, and also
entering charges into the costing document in order to raise invoices.
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The above image shows the “document status” view for a job, listing each of the documents created for it. As you can
see, a summary of the jobs profit/loss and invoices is also shown.

Printing out documentation

Each of the documents on a job may have against them a series of report templates you can print out. These report
templates can be formatted in any manner you like, form an exact laser printout to just having the bare minimal data for a
pre-printed stationary (such as printing on multipart stationary for AWB’s).

Perhaps the word “Report” is too general a term? For some people, “reports” are things that are run off when required in
order to see a statistical overview at the end of the day, month, quarter, or whatever. In FM3, “Reports” is a term used to
refer to any print out you may require.

Each of the documents you add to a job (such as “Export job” in the example diagram below) can be seen as a “data
entry form”, its layout being constrained by the size of your screen and the requirements of data you need to provide to it.
Once you have completed that form however, you will need to print out physical documentation to give to the

appropriate people. The layout of that physical documentation will more than likely not match that of the data entry form.

The following diagram tries to show you the association of reports to the documents on your job. Here we can see (in
this diagram, it may not be exactly the same for your configuration), that our BOL and HAWB have a list of reports
associated with them. You could see these reports when working with that document on a job, if you clicked on the
“Print” button in the toolbar. (note: the other documents on this job could easily have reports associated with them; it
would just be too much to show in this one diagram).

Again, taking our diagram a little further, a BOL may have a list of reports that may be printed, as can the HAWB, or any
of the other documents you see on a job.

FM3 provides a “Report Builder” tool that allows the data you entered to match your required layout (although possibly
this tool is too advanced to many users, and may be restricted to appropriate users anyway). Most of your “reports”
should have been configured during the initial installation and testing phase, but the presence of this tool allows a lot of
freedom to change your documents over time, adding new ones as required.
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The “Reports” window

When you are on a document (such as an “Export job”) and click the “Print” button (from either the toolbar or the “File”
menu), you will be shown the list of reports you can print out for that document. You are then able to select any of them
and either preview the selected report (prior to printing) or print it.

The example on the right shows a list of reports for an “Export job”, with each of reports you can print for this document
listed. You can either double click on one to preview it, or you can single click to highlight it (as per “airline manifest” in
this example), and then either click on the “Print” or “Preview” buttons towards the bottom.

The series of “tabs” at the bottom of the window, each representing a document on the current job. This allows you to
switch between them to print a report for that jobs document without having to close the “reports” window in order to
switch documents (And then clicking on the “print” button again).

Print Queue

If you want to print reports from each of the jobs documents in one go, say for example to send them all in one email,
then you can do this via the “Queue” tab.

You only need to “drag & drop” a report onto the “Queue” tab in order to add it to the print queue.

The options are the bottom of the list allow you to change the order of the items as well as remove them from the list.
You can right click in the list to quickly add any “Favourite” reports to the listing.
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Report folders

You can group a set of reports into a folder in order to save selecting them each time you wish to print them for a job. If
you are always printing (As per the example image) the “file front” and “Advice of Booking” reports, then you can right
click in the listing and select the appropriate options to create a folder. You can then drag these reports into it, and then
in future simply select the folder and print it to print all of the reports within it.

You can have as many folders as you wish. Each of the reports within the folder can have their out default output
settings, allowing you to send one report to printer A, another to printer B, another to a file, etc.
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Printing reports (output options)

When you click the “Print” button for a report, the print dialog window is shown. This allows you to select the output
mode you want to use for this report. Along the top, you will see three tabs, Printer, File, and Email, allowing you to send
the report printout via any of these methods.
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As you click on each of the output mode buttons along the top, the options change to suit.

In addition to being able to print your report to any of the available windows printers, you can also output a report to a
number of file formats (including PDF, Word (rtf), Excel, or ASCII text), via the “File” output option.

Printing to email

The first text box on this output mode allows you to supply an email address to send your report to. This box has two
buttons that allow you to select an email address already in your system. The first button lets you select an address from

your “Windows Address Book”, the 2nd to select an email address from the FM database itself, and its list of contacts for
each address. IN addition, a link to MS Outlooks list of contacts is possible.

Support for email templates is also available here, saving you time in entering job details into the email body. You are
free to create your own templates and edit the email body as required.
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If you have attached documents to your job you will also have an option to send those files along with your email, via an
“attachments” tab. Simply tick the boxes for the files to be attached.

Reports?

Reports are covered later in this document, as well as how to make simple changes to their layout using “Report Builder”.

Introducing the job window

When you open a job, you will be presented with its “Document status” window. This gives you a list of each of the
documents on the job, in order of their creation. To the left of the window you can see a “Task bar” with appropriate
actions as well as the documents themselves. The task bar allows you to open a document just by clicking on it (you can
also double click on any document in the document status listing seen below).
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As each document will give you a different set of boxes to fill in, we won’t go into them all right now, but rather get you
started on how to fill them in. So, let’s look at the common elements of a document (or data entry form) by opening up
the “Export Job”. You have probably just created one (as per the previous page of this guide), but if not you can do so
now.

We won’t go into the different boxes and what they mean just yet, but rather learn how to use the form.
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Picker boxes

These are the edit boxes that include a “…” button to their right, and are often used to enter a “code” that refers to a
relevant value. For example, on an export job, the “COD” refers to the country of destination, so its picker box could
have the code “FR”, which refers to “France”.

Clicking on that button should normally result in a “selection” window appearing, allowing you to pick out a relevant
record. So, in the case of COD, the selection window would list a series of country codes. But for an “Exporter”, it might
list a series of addresses.

You are free to type the code required directly into these picker boxes (if you know it), or you may click on the “…” button.
You should also be able to press the “F2” key on the keyboard for the same effect.

Most of these picker boxes will perform validation, meaning that if you enter an incomplete or invalid code, it will show
the picker window for you. You are then able to search for the relevant code or create a new one, as you see fit.

Some picker boxes may not lead you to a selection window, but rather a “detail” window where you can enter more data
about the job. One such example is the “Cube” box on the “Goods description” tab of the export job document. Clicking
this boxes “…” button will display a window where you can enter the dimensions for the various packages on this job.
Once done, it will calculate the cube for that picker box, and show the DIMS in the “Goods description” box.
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Tab pages

These allow parts of the interface to be hidden until needed. On our example “Export job” screen, you can see three
tabs along the top: Header, Details, and Goods Description. You can switch to these tabs at will using the mouse, or
when the tab has the “focus” if using the keyboard. You can tell if a tab has the “focus” as it will have a dotted rectangle
around it (the example on the right shows the “Header” tab as focused). When a tab has the focus, you can use the left/
right arrow keys on your keyboard to switch between the tabs.

Sometimes tabs are represented as buttons, such as within the “Details” page of our export job. In this case, the
different data entry boxes for different modes are only shown when the relevant button is clicked (the example on the
right shows the “Air” button selected).

Date pickers

Naturally you will need to enter dates and times into your forms. You can do this directly by typing into the box, or you
can also use a picker button to use a calendar to select a date. The calendar window that appears allows you to switch
between months/years, using the small arrow buttons found in its top left/right corners. To select a date, you only need
to click on it.
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Online context sensitive help

If you don’t know what a box on your current document form is for, you can often get online help by changing the task bar
page. At the bottom of the task bar in the job window is a page for “Help”. Click on this, and then as you move between
the various boxes on your form, you will see a help page shown.

In the example below, you can see we have gone to our Notify code box, and can get a description of what this box
expects.

Selection/Picker windows

As mentioned in the paragraph about “picker” boxes, you may need to select a relevant code from an appropriate
selection window. These may not all be the same, some will provide a basic list of codes and names for example, while
others may list address details. Most of these windows should some elements in common however, so let’s go over the
basics.
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When clicking on the “…” picker button for COD, the window below should appear.

As you can see, it’s a basic listing of country codes. This window however allows you to do more than just scroll through
the list to pick out your code. You can use the “Code” and “Description” boxes above the list to narrow the search down
(and thus find your desired entry faster). You can also use its dataset navigation toolbar (below the list) to jump up and
down the list, as well as adding new entries by hitting the “PLUS” button to add a new record.

Next, let’s look at an address picker window.

When on the “Exporter” code box, hitting its “…” picker button would display the following window. Again, we have a
similar layout, but this time with a few differences.

You can see a tick box towards the top left of this window that (in this example) has restricted our list to “Show only
Exporter” addresses.

Each address in the database can have a set of tick boxes assigned that dictate what type the address is, and as such,
allow us to reduce address picker windows like this to only the relevant addresses.

This can save time when searching for an address, but it may be that an address isn’t already marked up as the
appropriate type, so clearing the tick from this box allows you to see addresses of all types.

The “Show top” option allows us to speed up the search and only return a certain number of records from the server.
This is helpful when the database contains a lot of addresses and there may be a lot of users trying to access it.
Returning only a certain number of “matches” in this way allows us to reduce the load on the server and the network
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(displaying results much quicker too). You can lower this number further if it helps more often than not you know what
the address is you are looking for and so wont need to scroll through a large listing, but rather just enter the first couple
of letters of the company name into search box at the top of the window.

You can show all matching addresses by setting the “Show top” option to “0”. However, this shouldn’t be necessary in
most cases.

Edit / New

Unlike the picker window seen for COD, this address picker window presents two buttons to edit or add an address. This
was been done to allow more control over the permissions which allow entry of addresses, and also to allow the picker
window to respond faster by not being a full address editor window (in other words, the picker window doesn’t fetch all of
the address details, only the minimal required). This is a feature which can be tailored for each site however, using the
FM3 “user forms” functionality.

Database windows

The picker windows have to get their data from somewhere, and the “Database” menu is where most of this data can be
accessed and entered. We won’t go into details about what each window is for just yet, but rather introduce some of
their common elements. So, from the “Database” menu, select “Address Editor”.
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Some of this should be familiar now. We have a set of tabs at the top, and we are currently looking at the “Listing” tab.
At the top of this tab we have some filter options to search for data and narrow the listing down. Below these filter

options we have the listing of results itself, and below that another dataset navigation bar.

The filter options in this window work a little differently from the picker windows we’ve seen so far, as so need a little
more explanation.

The windows shown by the “Database” menu items, normally use filter options as seen in the above example, by which I
mean the “Search For” and “Search In” boxes.

The “Search In” drop down box allows you to pick a field to search on. The “Search for” box is then used to enter the
value to be looked for in that field. So, if you pick “CompanyName” as the “Search In” entry, and then enter “ABC” into
the “Search For” box, the listing will show those entries whose company name begins with “ABC”.

Some of the database menu item windows may allow you to search on date ranges too, its worth experimenting with
these options you cant do any harm as your only searching for data, not editing it.
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Searching for a job

Once you have created a number of jobs in the database, you may want to start searching for them (especially if you
can’t remember the reference number used for a particular job you did a month or two ago for a certain client). FM3
provides a configurable search tool for this purpose, so let’s start looking at this and how you may be able to use it for
various tasks.

The above is a typical search window (yours may not look exactly the same, see the Help tab and its section on the
“Configure” options for details).

Search Criteria

This tab allows us to define what it is we wish to search for. In the above screen shot, we don’t really have any criteria,
save for a “CountryDest” of “GB”. If we were to click on the “Search” button at this point, all of the jobs whose COD was
“GB” would be found (and I guess they would mostly be import jobs!)
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Each of the search values is listed vertically, and then the value you want to find is entered in the 2nd column to the right
of the value. In our example above, we have “GB”. This was typed directly in, but it could have been selected from a
selection window by clicking on the “…” picker button seen on the right.

Configure

This tab allows us to select which fields to show in the “Criteria” tab seen above. Here we can remove fields we don’t
want to search on, and add those which we do you can even change the order of the fields in the above list to be move
relevant to your interests.

Queries

This tab lists pre-save search criteria, allowing you to save time in searching for the same old data over and over (for
example, you may want to quickly search for export jobs entered in the last month or 3, or only those jobs that were on a
given route).

Help

This tab details more information on how you can best use this search tool.

Save Query

This button will save the search criteria you have entered, along with the “configured” fields (the lists of fields you setup
within the “configure” tab, so the “display”, “Group by” and “Order by” fields). When you click the button you will be asked
for a query name. Enter something that is unique and relates to the query criteria (such as “export jobs to france”). That
query will be added to the list seen in the “queries” tab, allowing you to simply double click it to run that query again in
future (or to use the “edit” option to amend the query further)

Results

When the query runs, your search results are shown within a “results” window. This may have a “group” tree on the left
(if you configured the “group by” fields), and the list of results on the right.

The results can be narrowed down by selecting an appropriate group from the tree on the left (the example is narrowed
down to air jobs (“A”) for the LHR office code, using the service code “BKKLHR”). You can also use the filter options at
the top to narrow down your results to find the data you’re interested in. The filter options only affect the data in your
existing results, and will not expand the search to include items excluded from the original query. The filtering is simply a
means to quickly search without having to ask the server for data you may already have in your existing results.

Feel free to experiment with the options in the results window, as you cant do any harm to the data here (its all read
only). Double click on a job entry (or anywhere on a row in the results grid on the right) to open that job.
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Creating a new job

When you click the “New” button in the toolbar, or from the “File” menu, you may see a window similar to the one below
(except in this example I have selected the “Job” type from the left, and then the “Export job” document on the right).

The various documents you are able to create in FM3 are grouped by type, so when you select a type from the list on the
left, you will a list of applicable documents on the right. When you select a document, you may see an automatic
reference number appear towards the bottom left (some documents may not have an automatic reference number and
so you will be able to enter your own reference here instead).

To create the new job, just select the required document (as per the example on the left) and then click on the “Create”
button.
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When you have a job window, you will be using this same “NEW” window to add documents to that job, only in that case,
you would already have the job window open, and would need to tick the “Add to existing job” option in the “NEW”
window. A further option allows you to decide if the new document should “inherit data from main”, as in inheriting data
from the “job” document to save you re-entering the same information into the new document.

Department

This selection box may not apply to you most of the time; however it can come into play within larger organisations that
have set up reference numbers based upon department codes. If you have offices in London, Manchester, and
Birmingham, then you may want each of those offices to use job references that have an appropriate job suffix (say, a
letter code). This drop down list box will allow you to perform this action. This would have been set up during the initial
configuration and testing phase.

Job Costing: Raising invoices

As you are no doubt aware by now, every job window lists a set of actions in its task bar to the left of the job window.
Among these is the “Enter Charges” task. Clicking on this item will open the job costing window which allows you to

enter a series of sales charges and costs against the job. These can then be converted into sales invoices, credit notes,
or enter “accruals” to be turned into “actuals” when invoices come in from your suppliers.

There are two types of charge you can enter, each into their own grid: Sales and Accruals. Sales charge lines are the
ones you expect to charge your client for the job, so you will raise these into “Invoices” or “Credit Notes” (or even “Duty/
Vat Invoices” and credit notes if you want to generate them). Accruals are the costs you expect to be charged by your
suppliers for work in relation to this job. These will eventually be converted into “actuals” when you receive an invoice
from your supplier (which you would enter via the “Purchase approval” function discussed later on).
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Entering charges into either grid involves the same process at the bare minimum you would enter an address code, a
charge code, and an amount to be charged, for each charge line. You can optionally enter more details, such as
currencies to charge and invoice, but you don’t need to if you don’t have to. Let’s look over the costing form in the
example image below.

The screen here is broken up into 3 grids Sales, Accruals, and Actuals. The first two grids allow you to enter data into

them; the 3rd does not, and is there for information purposes only. The summary totals at the bottom (below the actuals
grid) show a few summary details for the jobs profit/loss totals, and it’s updated when you save or open the costing.

To enter a new sales charge, click into the grid, specially the “Client” column, and start typing into the box. You can enter
any address code you like, or click on the “…” picker button to select from the address selection window (or hit the F2
key on the keyboard). You can see in our example image that “SIG0001” has been entered as an address code.

Next you should hit the TAB key, and then enter a “ChgCode”. A charge code is the identifier for the item you are
charging for, and can be likened to the nominal codes used in your accounts package, or, if you like, a charge code could
be described as a reference to a product. When you enter a charge code and press the TAB key, you will see the
description for that code show in the grid. You should now be on the “ChgAmount” column, where in your can enter the
amount to be charged. That’s it by and large. But what if you wanted to enter charges in a currency other than your
default? That’s where the other columns come into play:
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You don’t need to enter any of these extra details unless you have to, so if you are only ever raising invoices in your
home currency, don’t worry about them. You can get into a pattern where you enter an address code, hit TAB, enter a
charge code, hit TAB, then an amount, and then use the DOWN ARROW key on the keyboard, followed by HOME to do
the same again. The new charge line will use the same address code as that you last entered, so you wouldn’t even
need to enter that again if you are entering a series of charges for the same client. Of course, you can enter a different
client in order to enter charges for someone else, and thus raise a separate invoice.

Accruals

These work in pretty much the same way as entering the Sales lines, only you enter a Supplier address code instead of
a client, and you don’t need to enter an invoice currency/amount.

Accruals are the costs you expect to be charged by your supplier for this job, and are used to estimate your jobs profit
and loss totals.

Creating an invoice

Now you know how to enter a charge line, feel free to enter one or two more. Once done (although you can enter only
the one line if you wish), you will be able to click on the BATCH button (top right of the sales grid). This will turn the
charge line BLUE to indicate that it is “batched”. The “Unbatch” button will reverse this. (note: these options may not be
available if your user group has not been given permission to generate invoices)
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Once batched, you can click on the “Raise” button to see the “Invoice Generation Wizard” window. This window allows
us to control how and what is raised into an invoice, but for now, let’s skim through it in order to convert our charge line
into an invoice.

First, the invoice generation wizard is a general tool that allows us to create invoices from the charge lines entered onto
jobs. As such, it’s possibly a little more that you need in most cases; happily however you don’t need to delve into its
features just yet.

The first screen you see (example to left) allows some control over the “search” criteria that will go into finding the charge
lines we wish to raise. As we have opened this window from the job (as opposed from the “Accounts” menu.

The search criteria here has already been configured to look for charges on our current job, so we don’t really need to do
anything other than hit the NEXT button to proceed to the next stage.

The wizard looks for charges that it can raise into invoices, and then gives you a summary of those it thinks it can create.
This listing breaks down the charges into the various types so that “invoices” are grouped together, separately from

“Credit notes”. You can choose to create all the invoices listed, or simply pick the individual ones you want, by clicking in
the box on the left (in the “type” column). As you select each individual invoice, the groups header shows the total of
those you have selected.

When raising an invoice against a job, this feature is not really relevant, but it comes into play when you batch charges
on multiple jobs without raising the invoice from those jobs. When you come to open the “Invoice Generation Wizard”
from the “Accounts” menu, this stage of the wizard will make more sense. Especially if you have a client who you invoice
on something other than a “per job” basis (see “Invoice frequencies” later in this document).
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Once you have selected the required items in the list (as per image to the right), by ensuring a “cross” is in the
appropriate boxes, click the NEXT button to see a summary of the selections made. You can then choose to either go
back and make changes, or to click on the “Generate” button to actually create the invoice(s).

Once raised, you will see a summary of the generation process, listing each of the invoices created, and if any had
problems, those which it failed to generate. You can at this point choose to select the “Print Now” button.

Print Now

This button will open the “Sales View” window (found in the “Accounts” menu, within the “Sales” sub menu), and then list
the invoices it has just created, and will show the list of reports for sales view so that you can print out the appropriate
one. Each invoice generation session assigns its invoices a session id reference. This is basically a user name and
date/time stamp. This session id can be used at any time to reprint the invoices created in a single generation run
should you need to.
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When done, simply close the reports window, and the sales view window. You don’t have to use “Print now” to print a
jobs invoice you could do the same thing by selecting the relevant “Invoice” item from the jobs task bar.

Green costing lines?

Now that the charges have been raised - the charge lines that you batched should have changed to a different colour
(default configuration sets this as green for invoices, pink/red for credit notes). Each charge line will also show the
relevant invoice number in the appropriate column. Once raised, a charge line can not be edited.

Invoice Frequencies

Each client can have a different invoice frequency, to govern how charges on their jobs are raised into invoices. The
following frequencies determine how the charges get split up, or grouped together, onto invoices for that client.

Per Job

Charges entered onto a job will be placed onto the one invoice. If you have entered charges onto multiple jobs for the
same client (who has this invoice frequency), and have batched them all, when you come to use the “Invoice generation
wizard”, each job will get its own invoice for the charges entered against it.

Daily

Charges entered against multiple jobs will be placed onto the same invoice if their “date” occurs on the same day.

Weekly

Like Daily, this will place charges from multiple jobs onto the same invoice for a client. A week is seen as running from
Monday to Sunday, and uses the ISO standard week number format to determine the week number.

Monthly

Again, like daily and weekly, only this frequency looks at the month the charge is in. All charges for the same month will
be placed onto the one invoice.
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Quarterly

This frequency looks at the yearly quarter in which the month falls, January to March being the 1st quarter.

NOTE:

With each of these frequencies, once an invoice is created, you can’t add more charges to it even though it’s in the same
“frequency” (be that day, week, month, etc). You can not keep batching charges and adding them to the same invoice.
In other words, if you enter charges for a given day, batch them and generate the invoice(s), if you were then to enter

more charges for the same day they will end up being placed onto a separate invoice.

The “Consolidated” frequency however is different.

The “Consolidated” Frequency

This is a special case. It allows you to keep entering charges and raising them into the same invoice. That is to say, the
first job you enter charges for will result in invoice “X”. If you enter charges into another job for that client and raise them,
they will be placed onto the same invoice, not a new one. You can keep doing this until the invoice is “printed” or the
batch it belongs to is closed.

This frequency allows you to control charges for a customer to issue the invoice when you feel appropriate, or should
none of the time interval related frequencies listed above apply.

Tax Point Date

This date picker within the invoice generation wizard is worth pointing out. This is the date that your invoice(s) will be
given. It should default to the “processing” or “invoicing” date you supplied at login, but you can change it here to raise
your invoice within another day/month. This is useful from an Accounts point of view as you can prevent people from
raising invoices outside of your current accounting month.

Quick Job Costing

This function, not normally used by most people, allows you to search for jobs and enter charges against them all within
the one window. This is opposed to using the search function in the file menu to find the jobs you are interested in,
opening them, entering charges, closing, looking for the next one, etc.

Click on the “Quick Job Costing” option, available from the “Accounts” menu, and you should see a screen similar to that
below.
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The area to the right should be largely familiar, as it’s pretty similar to the costing screen seen from within a job window,
so we won’t go over this area as it should all operate in the same way.

The area to the left however needs some explanation. This area is where we can look for and select the jobs that we
wish to edit charges. Along the top left we have three tabs, Jobs, Search, and Config. Let’s start with the “Jobs” tab.

Jobs Tab

This is split into two halves, the top shows some summary details for the job currently selected, and the bottom the list of
jobs found (with the selected job being the one whose summary details we see in the top half, and whose charges we
are currently editing).

In order to find other jobs, we need to switch to the “Search” tab.

Search Tab

As seen to the right, the search tab presents us with some options to search for jobs. The first being “Created” dates
(after/before). Clear the tick from the boxes in these date pickers to search for “all” jobs. You can also narrow down the
results by entering a fileref, client code, or AWB number. You can enter a partial reference in these boxes and the search
will look for anything that “begins” with that value (so, a file ref of AE will find AE1234).
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The “Documents on Job” tick box allows you to search for jobs that may have any of the documents selected in the list
below. So, if you tick the entry for document “Bill of lading” (And if “documents on job” above the list is also ticked) then
the search results will only include jobs which have a “Bill Of Lading” document attached. The “documents on job” tick
box allows you to quickly turn on/off the document search should you want to try searching with and without them rather
than un-ticking the individual document entries in the list.

To see your search results at any time, just switch back to the Jobs tab. Below we can see the job used earlier when
looking at entering charges directly into the job.

You may have noticed by now that the list of jobs is contained within a “Search Results” tab, and that next to this is a
“Job” tab. This tab provides an extra means of quickly looking for a job in order to enter charges against it without having
to use the search functionality, so let’s have a look at this.
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The “Job” Tab

As you can see, there are three options to search for a job, FileRef, HAWB, and MAWB. Each of these is a drop down
list box, and there is also an extra “->” button to the right of them.

The drop down lists display search results, based upon whatever you initially type in the box. Type the start of a job
reference, and then click on the drop down arrow to see a list of 150 matches (the limit is for performance reasons, it
being a reasonable assumption that you won’t need that many results in this list anyway, as most of the time you will
know the job reference you want).

When you have entered the reference you are interested in from the list, click on the “->” arrow button to show that jobs
charges to the right.

Note: The charges grids in quick job costing also display the jobs reference above each grid. This is a useful
confirmation of the job you are working on.
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The “Config” tab

This final tab of our initial three allows you to change which fields are shown in the job summary listing, as well as the
colours used in the results grid for the jobs listed.

To change the fields used in the summary list, select one from the drop down list and click the add button, or use the up/
down/remove buttons below the list. Clearing the tick from the “Job summary listing” tick box will hide the summary
information from the top half of the “jobs” tab.
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Purchase approval

Having covered entry of sales charges, and accruals, we now need to be able to do something with those accruals when
an invoice arrives from a supplier. Within the “Accounts” menu is a “purchase” sub menu, and within there is the option
for “Purchase invoices”. This will open a listing window showing purchase invoices already entered (there shouldn’t be
any yet if you’re using the demo database).

The window is pretty simple, and most of its layout should already be familiar, with the filter bar at the top to reduce the
search results that are shown in the listing below. A new element in this filter bar is the “Type” box. We shall come back
to this later, first, lets go over how to enter a purchase invoice.
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Creating a new purchase invoice

Click on the “New Invoice” button to see the purchase approval wizard. The first page of which we don’t need to worry
about at the moment as its mostly for information, so click on the NEXT button and you should see something akin to the
following example on the right.

To create your invoice you need to enter the details on this screen (all are required apart from the NOTES box, which is
entirely optional for your use).

You first need to enter the supplier code, and then the type (99% of the time this would be as shown, Purchase invoice).

The “Invoice number” is the one the supplier uses on their invoice and not normally your own reference number.
Likewise, the Date is more than likely the one the invoice shows rather than being “todays” date. The currency is the one
the invoice is charging you in, with the ROE being used to convert from the Invoice amount to the Home Amount. The
VAT is normally calculated for you when you enter the Invoice amount (at a rate of 17.5%) but you can edit this straight
away, or set it as zero. The VAT amount is only calculated for you when the box is empty (a value of “0.0” is not seen as
an empty box). Click the NEXT button to move to the next stage assigning accruals/charges to this invoice.
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We initially have an empty listing, as we have not yet assigned any charges to this invoice. At the bottom we have some
running totals so we can see how much is still to be assigned to this invoice (balance being the remaining amount, here
I’ve created an invoice for £100).
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Assign accruals to the invoice

The usual way to assign accruals to an invoice is to use the “Search” button (towards the bottom right). This will display
a screen similar to that on the right. By default it will use the same supplier code as used on your invoice (in this case,
“BA”). You can change this search criteria as you see fit, and then click the “NEXT” button to see a list of accruals which
match.
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The list of results (shown below right) can then be used to “tick” the lines for those accruals you wish to assign to the
invoice. As you tick each line you want to assign, the “total” is updated below the list, giving you an idea if you are near
to matching the invoices total. Once you have ticked the items you want to assign to the invoice, click on the “Assign”
button. (You may see a message asking if you want to close the search form if you say no then you will be taken back
to the search criteria to find some more accruals to assign. Otherwise, you will most likely click “yes”.

Once the accruals have been assigned to your invoice, you are free to edit the amounts if the accrual amount isn’t the
“real” amount shown on the purchase invoice (or rather, the “actual” amount.

It’s worth noting what has happened so far. When an accrual is assigned to a purchase invoice, the original “accrual” line
is actually changed into an “Estimate” line, and a copy of it is created against the invoice as a “Purchase invoice” line
(also known as the “actual”). You are then able to edit the “actual” line to correct the amounts as needed. Doing this
gives you a variance value in your jobs profit and loss figures (variance between estimated profit and actual profit).
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Alternative way to enter charges onto an invoice

You could, if you wanted, not bother entering accruals onto a job, but rather directly enter them onto the purchase invoice
as you approve it. You are free to enter a new line at any time with a job reference, charge code, amount, etc, just like a
normal costing grid.

When finished approve it

When you have finished entering charges onto your invoice, click NEXT to proceed to the final page, “approval”. If your
charge line totals don’t match the invoice amount, then you are looking at partially approving the invoice (in our example
below, partial approval has been turned off, so hitting CANCEL will result in the charges all being undone and the
“actuals” being deleted and the “Estimates” reverted back to begin “accruals”). Otherwise, you could click the “finish”
button to partially approve the invoice, whereupon it would be available in the “Daybook” to complete at a later time (see
below).
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On the right you can see the screen used when the charges amounts total up with the invoice amount. This is the
approval screen where you can assign the invoice to a new or pre-existing batch.

Daybook

The purchase invoices listing window includes a “Type” search filter. This item allows you to restrict the results to shown
only “Purchase Invoice” items, or “Purchase Credit” items, or as we will need to explain, “Daybook” items.

Daybook entries are partially approved purchase invoices, waiting to be fully approved. This is to say, those purchase
invoices you have started entering but have not yet fully approved (as you could only approved a few charge lines due to
information being wrong or details being checked). You can continue editing it by doing the following:

• Select the partially approved invoice from the listing
• Switch to the “Invoice” tab
• Click on the “Edit” button towards the bottom left

You can also see a “Delete” button here. You can only delete a purchase invoice if it has no charge lines assigned. In
this way, if you have partially approved an invoice, and want to undo it, remove the lines from it within the approval
wizard (using the DELETE button in the dataset navigation toolbar seen below the grid within the wizard), and then once
there are no more charge lines on the invoice, partially approve it. You will then be able to delete it from the listing, free
to recreate it.

Profit/Loss Reports

Being able to create jobs and entering charges against them allows you to review the amount of profit (or loss) against
them. To facilitate this you can first use the “totals” tab of the costing form (seen when you use “enter charges” in a job
window).

Additionally you can use the “Profit/Loss” tools within the “Utilities” sub menu within the “Accounts” menu. This window
operates in a similar way to the “search” utility available from the “file” menu, except that the “Profit/Loss” form provides
two criteria lists instead of one.
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The top half of the criteria tab shows the search criteria fields you can use against the jobs, the bottom half search
criteria for the charge lines against those jobs. You can use either as needed, but by doing so different results will
appear. For example, if you only use the top half then your search results will only contain the job data and job summary
totals. If you enter search criteria in the bottom half, then the results will include details for each charge line entered
against the matching jobs.

Transfer to Accounts

Entering your sales/purchase invoices into FM may be fine for some purposes, but you may need that data within your
accounts package. FM3 provides a feature to “transfer” the invoices once batch at a time to a text file, which can then be
imported into your accounts package. By default this file format is aimed at Sage Line 50, but we should be able to
customise this feature for different accounts packages as required.

The “transfer” window allows you to find a batch, close it, then “transfer” it. A batch must be closed in order to prevent
additional invoices from being added to it before you have finished the transfer process.

Basic Report Builder tips

We often get support calls asking how to make small changes to reports. Assuming you have permission to do so, the
following pointers will come in handy.

Any of your reports may be edited at any time to fine tune them. This can include the positioning of say the clients
address, or the job reference number. Or it could be changing the font used, or changing the company logo. To edit a
report, first of all open the jobs document to which the report belongs. Then click on the print button found in the toolbar
to see the “Reports” window. In the example below, I have opened an export job.

Right click on the report you wish to edit, then select “Report” and then “Edit Report” as per the example image on the
right. This will open the report template within “Report Builder”, a GUI tool used to design the layout of your report print
outs.
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It may be a good idea to get acquainted with the layout of this window.
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The report builder window may seem intimidating at first, but its not as bad as things seem, especially if you only want to
do minor things like move a the words “Airline Manifest” around, or just edit them. So let’s go over what we have on the
screen.

Along the top we have the normal “menu bar”, and below this a set of tabs (“Design” being selected at present in the
previous example). Along the top of the design tab we have some toolbars. These contain a mix of new and familiar
items, described on the following pages.

Standard components toolbar

These buttons allow us to place “static” items onto the reports design area. The important thing to notice for now is that
the “Arrow” is highlighted. This signifies that we are in “select” mode and means that when we click on the reports
design area that no item will be added, rather, that we are able to click on any existing item (Such as the logo) to select
it.

The buttons in this toolbar are as follows:
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Data components toolbar

To the right of the “standard” components is the “data” components toolbar. These buttons allow us to place boxes on
the design layout that will fetch their contents from the database (or rather the jobs document which we are currently
editing the report for). These items are similar to those of the “Standard components” toolbar, but are normally linked to
a field from the database (or rather, the jobs document you are editing this report against).

You can hover over each of the buttons in the toolbar to see a tool tip that describes it.

Sigma - Getting started with FM3

Page 45Sigma - Getting started with FM3



Changing the caption of a label

On our current report, we can see the caption “AIRLINE MANIFEST” at the top of the design area. To change this
caption, first select the box. When selected, you will see that the label has small round “handles” around it. These can
be used to resize the box by “dragging” them with your mouse. You can move the entire label box but dragging it around
the design layout.

Towards the top left of the report builder window is a toolbar that contains a text box this should be showing the contents
of the labels caption, “AIRLINE MANIFEST”. You can click in this box and edit the text as you feel fit.

Changing font size/colour

While we have this label selected, you can also change its font type, size, colour, etc, by using the standard font
manipulation toolbar options. These should be familiar if you have used MS office applications such as MS Word or
Excel.

Its worth experimenting with these options if you are not familiar with them.

Saving changes

From the “File” menu, select “Save report using wizard”. Click on the “Next” button of the window that appears. You are
now free to make further edits, or to close the report builder window to continue working or to edit another report (reports
are saved within the database itself, and not as individual files on the server or your pc).

Drawing Boxes and Lines

A lot of documents use boxes and lines to help break up the content and separate out sections of data, or to mimic the
layout of “pre-printed” stationary. Using these lines on a report is rather straight forward, once you know how.

Drawing a box and changing its shape

Within the report builder toolbar you will find the “shape” option (seen left). Click on this and then click on the design
area of your report. You should now have a square on your report (as per the image on the right).
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If you drag one of the little round “handles” you will resize this box, and quickly notices that this square is actually a
rectangle. You can change the shape to being a circle or triangle by using the drop down list seen in the toolbar (it
should be set as “Rectangle” until you click on the drop down arrow). Select any of the shapes in the list and the shape
on your design will change.

Drawing lines

This is similar to drawing a box, but this time you can click on the “Line” button in the toolbar (seen left), and then clicking
on the design area to place a new line (similar to that shown on the right).

Again, you can resize the line by dragging the handles, but you will notice that the handles are like a box, and that the
line is currently running along the top of that box. If you want a vertical line, you can select from the drop down list in the
toolbar in a similar way to the way we changed shapes earlier (right).

You can change the colour and thickness of the line via the options in the “Draw” toolbar shown on the right. If you can’t
see this, you can turn it on via the “Toolbars” option in the “View” menu, or by right clicking on an existing toolbar.

Feel free to experiment with combining shapes and lines to create complex layouts.

Layered objects

When you draw multiple objects on a design layout (such as a series of shapes and lines), you may find that you have
one above another. This might not be what you want in some cases. Fortunately, you can move objects behind one
another by selecting “Move to back” or “Bring to Front” when you right click on them. In the example images (right) I
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have drawn a line and moved it over a shape. As you can see, the line appears to run through the box. If I right click on
the box and select “Bring to front” then the line will appear to run behind the box.

Colours and “Transparency”

The line is hidden behind the box as the box itself is actually filled in with a colour (in this case white). We can make the
box “transparent” to show the line by selecting the “No Fill” option from the draw menu (right).

Moving items around the layout

As you are already aware, you can move and drag items around the design view simply by dragging them with your
mouse. You can also do so using the keyboard. Select an item by clicking on it once to highlight it (so that you see the
round handles, as per the examples already seen on this page). Next, use the “arrow” keys on your keyboard whilst
holding down the control key (CTRL). This will move the object one pixel at a time. You can do the same thing with the
“nudge” toolbar (right).

You can resize the object in a similar way, but this time holding down the SHIFT key instead of CTRL, whilst you press
the relevant arrow key.

There are two other toolbars (Along with the nudge toolbar) which you may find useful when trying to resize and line
items up on your reports design. These are the “size” and “Align or Space” toolbars.
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Object properties

Each object on your reports layout has a series of “Properties”, which you mostly manipulate via the mouse. These are
things that determine the objects position on the layout, its colour, etc, but some settings are might be best edited via the
“Report Tree” toolbar window. This may already be visible, but if not, you can turn it on via the “Toolbars” setting in the
“View” menu.

The top half of the window shows a hierarchical structure of the items on your report. The bottom half the properties for
the item currently selected.

You can change these properties as you see fit to change the object. For example, every object has a unique
“UserName” which defaults to the name of the type of object followed by a number. You might prefer to rename these to
something more friendly and meaningful to make selecting the item from the tree easier (as well as editing code for the
item if you want to delve deeper into the report builders features).

Getting different data onto the report

Rather a basic requirement, but not mentioned until now, you obviously may need to show different data from your jobs/
documents on your report. This can be to show a HAWB number instead of a MAWB number.

Data is provided via what Report Builder calls “pipelines”. Each one representing different data. Some pipelines contain
only one entry (such as that for an AWB), others may contain multiple lines (such as the charge lines for an invoice). A
pipeline may have several fields within it, each representing a different item of data from your jobs document. For
example, an address is broken down into its “name”, “post code”, “Telephone” etc.
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o show data from these pipelines, we first need to add a “dbText” item to the report (right). In the toolbar you can now
select a pipeline and a field from that pipeline to be shown in this dbText box. In the example on the right, I have
selected the “JobTab” pipeline and the “File_Ref” field to show the jobs reference number in the dbText box.

This is another example of a feature that you should play with until you are happy with the concept. However, in order to
know what field to show for certain documents, you will need to experiment (or call technical support). For reasons I’m
sure you can appreciate we can’t really go into what fields contain which values in this document.

Report Code

Every object on the report can be manipulated at “run time” (that is to say, when its being processed to be printed or
previewed). You could hide/show objects on the report based upon the data currently being printed. For example, you
might want to show a warning on a report if a value hasn’t been supplied to a certain value, or perform a calculation
based on the data provided.

Editing the “code” used by a report is a topic beyond the scope of this document, suffice it to say that there are examples
within the databases reports already. If you want to see a simple example for yourself, we suggest you try to edit an
invoice report. Within there you may find code that performs various tasks, such as the following:
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This code displays a jobs HAWB if the jobs mode is A (air), or the house bill of lading if the job is a sea job (S), and
nothing if the job is a road job (r).

Don’t worry if you don’t understand it, but if you do then perhaps you can see the potential power of the report builders
“RAP” code feature.

Report Data

In addition to adding code to a report, you can pull in extra data from the database (And any other windows database) for
use in the report. The data tab allows you to define an SQL query, or build search criteria via its GUI, to fetch data into
the report. Each search criteria definition appears as a separate window within the “Data” tab, to add new ones use the
“file” menu via the “New” option, where you can use the “Data wizard” or the “Query builder” to define your search
criteria.

Support and Contact

Should you need help, more information, or simply to comment on this document, you can contact us online, via phone,
or that old standby, “mail”.

Email: Support@SigmaFreight.com or Support@SigmaFreight.co.uk

Online: http://www.SigmaFreight.com/

Phone/Fax: 0871 374 2020
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